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Abstract: In this study, the iron-rich heavy mineral concentrate production from river sand as a byproduct of an alternative resource by gravity, magnetic separation, and flotation methods were
investigated in detail. For the physical separation of the sample and increasing the Fe2O3 content, a
shaking table and a wet high-intensity magnetic separator were used, respectively. The gravity and
magnetic separation experiments included rougher, cleaner, and scavenger circuits. In the flotation
experiments, cationic flotation with ethylenediamine under acidic conditions, and anionic flotation with
sodium oleate under alkaline conditions were performed. The iron and silica content of the products
obtained were determined by digital image processing (DIP) methods and compared with the classical
analytical procedures. Finally, a flow chart was proposed for the processing of the ore according to the
optimum enrichment parameters were determined from the experiments. The results obtained in this
study show that it is possible to produce an iron-rich heavy mineral concentrate with Fe2O3 grade and
recovery rate of 79.13% and 57.81%, respectively, in addition to a potential feed for the production of
quartz sand and feldspar concentrates.
Keywords: gravity separation, magnetic separation, flotation, silica, iron, magnetite
1. Introduction
Silica sand, which is formed by the decomposition of quartz-rich magmatic and metamorphic rocks, is
a raw material commonly used in glass, cement, detergent, plastic, ceramic, electronics, paint, casting,
and metallurgical industries. In general, it is desired that the SiO2 content of silica sand used in glass
production must be no less than 99%. Silica sands with stable chemical composition and low Fe2O3
content (<0.02-0.1%) are generally preferred in glass production. Accordingly, silica sand is subjected
to mineral processing to comply with physical or chemical specifications (Kose and Tureli, 1986;
Ubaldini et al., 1996; Hacifazlioglu, 2011). Also, the beach and river sediments have been used in glass
production. For example, river sediments are rich in silicate minerals like quartz and feldspar.
Upgrading river sediments by physical processing methods such as gravity, magnetic, and electric
separation methods showed that the silica content of river sediment can be enriched from 60-70% to
94% (Rajib et al., 2009). Rahman et al. (2015) stated that after the separation of heavy minerals from the
river sand of Bangladesh, the resulting quartz-rich fraction can be used in glass production.
Additionally, it was stated that an iron-rich concentrate (>60%) can be obtained from the same deposit
with the physical separation methods.
Iron is the fourth most abundant metal in the Earth's crust after aluminium and the second most
abundant metal in general. The main ore minerals of iron are hematite, magnetite, titano-magnetite,
goethite, and siderite. Today, in many countries, most of the rich iron ore reserves are depleted and the
sustainable production of low-grade iron ores has become a critical debate in the mining industry. For
example, magnetite and ilmenite deposits are common in coastal sands. Many such deposits have been
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studied as potential sources of iron ore (Christie and Brathwaite, 1997; Liu et al., 2014). Magnetic
separation is the most economical and environmentally friendly method used for iron ore processing.
However, iron ores need to be enriched using a process suitable according to the properties such as
mineral composition, physical properties, and liberation degree between iron-containing/gangue
minerals. In the recovery of iron from low-grade iron ore; the application of various methods such as
flotation, gravity separation, and magnetic separation has been investigated by many researchers (Li et
al., 2010; Seifelnassr et al., 2013; Filippov et al., 2014).
Traditionally high precision multi-element analysis has been performed in analytical laboratories on
the ore samples using standard techniques such as X-ray fluorescence (XRF) and Inductively coupled
plasma (ICP) spectroscopies. These analyzes typically provide data that can lag the production of the
mine or plant due to intensive sample preparation (Endo and Sakao, 1980; Death et al., 2008). These
traditional techniques have also been used for iron ore analysis (Bhargava, 2006). In addition to the
abovementioned disadvantages such as extended sample preparation durations, these techniques,
especially wet chemical analysis methods that require the use of strong acids at the digestion step, have
the potential to pollute the environment (Sheng et al., 2015).
Digital image processing (DIP) is the use of computer algorithms to perform image processing on
digital images. The high flexibility of the DIP methods makes it useful in a wide variety of processes
(Billingsley, 1970; Cao, 2006). Therefore, such methods are used in many disciplines including medicine,
geodesy, photogrammetry, earth sciences, chemistry, astrophysics, biotechnology, and metallurgy
(Maras et al., 2010). Moreover, the DIP method has been used for the evaluation of several processes
such as flotation (Moolman et al., 1994; Aldrich et al., 2010), particle size distribution analysis (Kursun,
2009), and solid-liquid separation (Stanford et al., 1992) in the mineral processing discipline.
Alternatively, these methods have also been researched in several studies as an alternative to traditional
techniques used in ore grade analyzes (Singh and Rao, 2006; Khorram et al., 2011; Perez et al., 2011).
In this context, this study aimed to investigate the possibility of iron concentrate production from
silica-rich river sediment with high iron content by gravity, magnetic separation, and flotation methods.
Moreover, the application of the digital image processing methods as an alternative to classical
analytical analysis methods in determining the iron and silica content of the products obtained was
evaluated and discussed in detail. Finally, a flow chart was proposed for a possible scale-up ore
processing based on the optimum parameters.
2.

Materials and methods

2.1. Materials
The Silica-rich river sediment sample used in the study was obtained from the Canakkale region,
Turkey. In the characterization studies; the physical, chemical, and mineralogical properties of the
samples were determined by particle size distribution analysis (PSD), chemical analyzes by inductively
coupled plasma mass spectrometry (ICP-MS) method, X-ray diffraction (XRD) analyzes, and optical
microscope investigations on the representative samples. The PSD and optical microscopy analyzes
were performed on the original samples. On the other hand, the samples were reduced to -75 µm particle
size using an agate grinder for instrumental analyzes such as ICP and XRD methods. ICP-MS analyzes
were carried out using Perkin Elmer Nexion 2000 to determine the major oxide contents of the sample.
Lithium tetraborate (Li2B4O7) fusion and nitric acid digestion methods were used for the preparation of
the samples for ICP analyzes. The results of the chemical analysis of the sample are presented in Table
1. As a result of chemical analysis, SiO2 and Fe2O3 contents of the sample were determined as 59.16%
and 6.82%, respectively. Accordingly, the sample was identified as a silica-rich ore with considerable
iron content.

The PSD analysis of the sample was performed under TS 3530 EN 933-1 standard by using
Retsch AS200 Basic sieve shaker and Impact brand ISO3310-1: 2000 test sieve series. The d80
and d50 sizes of the sample were determined as 867 µm and 364 µm, respectively (Fig. 1a). To
describe the minerals in the samples, XRD analyzes and mineralogical examinations were
carried out. XRD analyzes were performed using GNR APD 2000 Pro X-ray diffractometer,
and the measurements were realized under Cu-Kα radiation at 40 kV voltage and 30 mA
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Table 1. Major oxide contents of the sample
Oxides
Al2O3
Fe2O3
K2O
CaO
MgO
MnO
*

Assay Values (%)
18.82
6.82
1.43
3.89
0.72
0.15

Oxides
Na2O
P2O5
SiO2
TiO2
LOI*
Total

Assay Values (%)
4.55
Not Detected
59.16
0.80
2.15
98.49

Loss in ignition

current with a goniometer velocity of 2θ = 1o / min. The obtained XRD spectra were evaluated using
Philips Xpert Highscore software. A trinocular microscope (SOIF BK-POL) was used for the optical
examination and imaging studies. As seen in Fig. 1b, thedominant mineral in the sample was quartz,
mostly colorless but also observed in different colors. Iron content is mainly attributed to magnetite
mineral which is partly free and partly locked with quartz particles. Additionally, ilmenite and
titanomagnetite were identified as secondary iron-containing minerals. On the other hand, kaolinite
and albite minerals, which have lost their euhedral forms as a result of decomposition, were secondary
in the sample. Trace amounts of mica, rutile, and apatite minerals were also observed. It was determined
that the minerals in the sample did not accumulate in a certain fraction and showed a relatively
homogeneous distribution. However, it was found that the degree of liberalization, especially in terms
of quartz and magnetite, increased after the particle size of 125 µm. Additionally, the presence of
cemented structures with quartz and magnetite content having low breakage resistance was observed
especially in the fractions coarser than 1 mm.
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Fig. 1. (a) PSD results of the original sample, (b) Optical microscope images of different size fractions

2.2.

Methods

2.2.1. Sample preparation
According to the results of the mineralogical examination, the studies for the sample preparation were
carried out for examining the conditions of breaking the cemented structures observed in the +1 mm
fraction, besides, to obtain narrow particle size fractions suitable for the gravity and magnetic separation
experiments. The particles, coarser than 8 mm, were removed initially as they were not related to the
general mineralogical composition of the sample due to the transportation of pebble-sized particles at
the river bed. Subsequently, the remained sample was crushed to -1 mm using a roll crusher (Unal
Engineering, Turkey) in a closed circuit. The resulting sample was subjected to scrubbing to break free
the cemented structures and clean the particle surfaces from the potential contaminations. The effect of
scrubbing was investigated for 1, 5, and 10 min under constant conditions of 1000 rpm of mixing speed
and 50% solids. After the scrubbing, the sample was classified into 3 different size groups, namely 1×0.5,
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0.5×0.212, and 0.212×0.038 mm. Since the -0,038 mm fraction was out of the particle size range that could
be enriched effectively with the physical enrichment devices used within the scope of the study, it was
not included in the enrichment studies.
2.2.2. Pre-processing with gravity and magnetic separation methods
As the first step of enrichment experiments, it was decided to examine the pre-processing of the sample
by gravity separation considering the density differences between magnetite and gangue minerals and
the relatively coarse (~125 µm) liberation size of the particles. As mentioned in Section 2.2, the
experiments were performed using 3 different size groups to maximize the separation efficiency. A
laboratory-scale shaking table (Wilfley, UK) was used in the gravity separation experiments. The
experimental conditions were determined according to a previous study (Terzi, 2017) where the shaking
table separation of ore with similar physical characteristics was investigated. The variable parameters
used for the separations are presented in Table 2. The solids ratio of the pulp (25%), feed rate (6 kg/h),
and stroke amplitude (15 mm) parameters were kept constant in all experiments.
A laboratory-scale chamber-type wet high-intensity magnetic separator (Boxmag Rapid, UK) was
used in the magnetic separation experiments. The magnetic separation experiments were conducted at
different amperage (1A/2A/25A) levels to provide different magnetic intensities (0.22 T / 0.46 T / 1.9
T) for the cleaner and scavenger stages. At the initial stage, the gravity middling was scavenged at a
magnetic field intensity of 0.46 T to increase the recovery rate by the attraction of interlocked magnetitecontaining particles. Subsequently, the magnetic separation at a magnetic field intensity of 1.9 T was
applied on the resulted non-magnetic material to produce a possible feed for quartz/feldspar
production. Finally, the magnetic fraction that obtained at the magnetic field intensity of 0.46 T was
combined with the gravity concentrate and processed in a cleaner stage at a magnetic field intensity of
0.22 T. To reach the required magnetic field intensity values, 6 grids with 1.5 mm × 3 mm openings were
assembled in the separation chamber. Moreover, feeding was realized at a rate of 4 kg/h in a
discontinuous manner to prevent clogging in the separation chamber. The solids ratio of the pulp (25%)
was kept constant in all experiments.
Table 2. Experimental conditions of gravity separation
Particle Size
(mm)
1×0.5

0.5×0.212

0.212×0.038

Circuit
Rougher
Scavenger
Cleaner
Rougher
Scavenger
Cleaner
Rougher
Scavenger
Cleaner

Inclination
( o)
8
9
10
7
8
9
6
7
8

Stroke
(rpm)
340
370
400
370
400
430
400
430
460

Wash Water
(dm3/min)
10
9
8
9
8
7
8
7
6

2.2.3. Zeta potential measurements
The conventional flotation experiments were performed to obtain a final concentrate from the iron-rich
heavy mineral pre-concentrate. Zero point of charge (ZPC) is a very important feature used to
characterize the electrical double layer and the mineral surfaces in flotation. ZPC can be used to estimate
the charge of mineral surface whether it is positively or negatively charged at a given pH range. ZPC
values of different minerals in an ore are important in terms of determining the flotation conditions and
enabling the effective separation of one mineral from others (Jordens et al., 2013). Thus, the zeta
potential values of quartz and magnetite, which are the main gangue and ore minerals within the
sample, were measured to establish a route for the flotation experiments.
Since the magnetite-rich concentrate produced as a result of pre-enrichment does not have sufficient
purity to be used in zeta potential measurements, the sample was subjected to a magnetic separation
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process using a hand-magnet until the non-magnetic minerals in the sample were completely removed
(Fig. 2a and b). Additionally, as seen from the XRD result of the purified sample shown in Fig. 2c, the
sample was purified well enough for the measurements.
2.2.4. Flotation experiments
The conventional flotation experiments were conducted using a set-up consisting of a lab-scale Denver
D-12 flotation device and an Orion A211 tabletop pH meter. Reverse anionic and cationic flotation
(flotation of silicate minerals from iron concentrate) remains the most popular flotation scheme used in
the iron ore industry. While anionic collectors mainly consist of fatty acid, alkyl sulfonic acid, alkyl
sulfuric acid, alkyl hydroxamic acid, and sodium or potassium salts, various amines are used as cationic
collectors during reverse flotation of iron ores (Cao et al., 2013; Filippov et al., 2014). In the experiments,
the reverse flotation method was applied, and according to the results of zeta potential measurements,
the applicability of both anionic and cationic flotation schemes was examined. Flotigam EDA and NaOl
(>82% fatty acids) were used as the collectors in cationic and anionic flotation experiments, respectively.
Additionally, MIBC (98%) was used as a frother. CaCl2 (99.9%) was used as a quartz activator in anionic
flotation, HCl (37%) and NaOH (>99%) as pH adjusters, and corn starch (25% amylose/75%
amylopectin) as an iron depressant in anionic flotation. All of the reagents used in the flotation
experiments were purchased from Sigma Aldrich, USA except Flotigam EDA (Clariant, Switzerland)
and corn starch (Tekkim, Turkey). Moreover, mono-distilled water (GFL, Germany) was used in all
experiments. The conditions of the anionic and cationic flotation experiments are presented in Table 3.
Table 3. Experimental conditions of flotation experiments
Variable Conditions
Anionic
Cationic
Flotation
Flotation
11
3
500
200
500
100
500
500
-

pH
Collector (g/Mg) – C
Frother (g/Mg) – F
Depressant (g/Mg) – D
Activator (g/Mg) – A
(a)

S/L Ratio (%)

10

Mixing Speed (rpm)
Air Flow Rate (dm3/min)
C/D/A Conditioning (min)
F Conditioning (min)
Flotation Time (min)

1000
10
5
1
5

(c)

M

Intensity (Count)

M: Magnetite (Fe3O4)

M

M

150

(b)

Constant Conditions

M
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M

50

M

M

M

M

M

M

M

M

0
0

10

20

30

40

50

60

2Ɵ (Degree)

Fig. 2. Purification of magnetite pre-concentrate; (a) before, (b) after, (c) XRD result of the purified magnetite
sample

2.2.5. Evaluation of experimental results with a digital image processing method
The digital image processing (DIP) method, which was successfully applied in the evaluation of
processing results of ores that mainly contain minerals with obvious color differences such as feldspar
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in previous studies (Ozdemir et al., 2016; Kursun et al., 2018), was used in the determination of mineral
contents of the products obtained from flotation experiments, and indirect calculation of recovery rates.
In the DIP analyzes, the samples were photographed using an optical microscope under appropriate
lighting conditions, and the ratio of dark and light-colored minerals in the microscope images was
determined by using open-source ImageJ software. ImageJ is an open-source Java image processing
program. 8-bit, 16-bit, and 32-bit images can be analysed and processed in the program (ImageJ, 2020).
The percentage area value obtained after this process represents the cross-sectional area (CSA) of the
dark minerals in the sample relative to the white minerals. The image processing steps with ImageJ are
seen in Fig. 3, and the examples of the original and processed images are given in Fig. 4. The analysis
procedure performed on the microscope images with 3264x1836 resolution is as follows:

(a)

(c)

(b)

Fig. 3. Cross sectional area calculation with ImageJ (a) 8-bit conversion, (b) thresholding; (c) Area % calculation

As a first step, the microscope images were converted to 8-bit grayscale (Image>Type>8-bit) to
perform the thresholding (Fig. 3a). The resulting 8-bit images were converted to a 2-color (black and
white) by specifying a threshold value (Image>Adjust>Threshold). The threshold value was
determined automatically by software in the images of concentrates where dark minerals are
predominant, and manually in the images of concentrates where light minerals are predominant to an
optimum value where the processed image represents the original image in terms of black and white
minerals (Fig. 3b). The ratio of black pixels to white pixels in the 2-color image was calculated using
Analyze>Measure. The principle of the measurements is based on the calculation of the ratio of black
pixels to white pixels in any given image (Fig. 3c). This procedure was performed on 5 different images
taken from the fresh samples of each feed or processed product.
(a)

(c)

(b)

(d)

Fig. 4. Examples of (a-c) original images, (b-d) processed images

3.

Results and discussion

3.1. Effect of scrubbing on PSD
It was determined that the scrubbing process showed a significant effect on the PSD of the sample. The
ratio of the 1×0.038 mm fraction was increased to 83.69% from 78.92% after the 10-min scrubbing
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process. These results showed that the cemented structures were broken down and liberated effectively
and particle surfaces were cleaned from the contamination and passed to the slime fraction (-0.038 mm).
Although the PSD of the samples obtained at the 1st and 5th min of the scrubbing process was similar,
the optimum scrubbing time was determined as 10 min as a more prominent change was observed at
this duration.
3.2. Gravity separation
The results of gravity separation experiments are shown in Fig. 5. As a result of enrichment with a
shaking table, the CSA value of 1×0.5 mm fraction was increased to 35.30% from 7.66%. However, the
recovery was quite insufficient (~19%). It was determined that the primary reason for this situation can
be attributed to the fact that the behavior of the majority of dark-colored minerals was similar to light
minerals such as quartz, which were partly inter-locked with dark-colored minerals in this fraction, on
the middling and tailing zones of the table. These results revealed that it was not possible to achieve a
removal of tailing with a low iron grade, which was the primary goal of pre-enrichment in this fraction,
even with the scavenger stage. On the other hand, approximately 400% increment in the CSA value of
concentrate was a considerable result.
On the other hand, the CSA value of 0.5×0.212 mm fraction was increased to 74.83% from 14.48%.
Moreover, a much higher recovery (69.58%) compared to the 1×0.5 mm fraction was also obtained. The
higher liberation degree of this fraction had a significant effect on the results obtained. On the other
hand, it can be said that the target of rejecting a clean residue was reached only partially with the 5.46%
CSA of final tailings due to the significant amount of locked magnetite particles in this fraction. The
grade increase in the concentrate was consistent with the result obtained in the 1×0.5 mm size fraction.
Therefore, it can be said that the result obtained with this fraction was more compatible with the aims
of the pre-enrichment process owing to significantly higher recovery with a similar upgrade rate.
Finally, the CSA value of 0.212×0.038 mm fraction was increased to 83.46% from 13.44% with a
recovery rate of approximately 92%. The advantage of the highest particle liberation degree observed
in this fraction was positively affected both grade and recovery rate. Therefore, it can be said that the
target of obtaining a clean residue was successfully achieved in this fraction with the 1.04% CSA of the
final tailing. Therefore, an approximately 500% increase in the CSA value showed that the gravity
separation method can be applied with high success in this particle size fraction.
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Fig. 5. Results of gravity separation performed on (a) 1×0.5 mm fraction, (b) 0.5×0.212 mm fraction, (c) 0.212×0.038
mm fraction

3.3. Magnetic separation
The results of magnetic separation experiments are seen in Fig. 6. As a result of magnetic separation,
the CSA value of 1×0.5 mm gravity concentrate was increased from 35.30% to 56.97%. On the other
hand, due to the low particle liberation, the recovery rate was not exceeded by 79.72%. The overall
recovery obtained in the sequential application of the gravity and magnetic separation process was
about 15.61%. Moreover, the CSA value of gravity middling was decreased from 3.92% to 2.50% by twostage magnetic separation applied at 2 A and 25 A. Accordingly, it can be said that the evaluation of the
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obtained product from this step as a potential feed sample for quartz/feldspar recovery was a
considerable option. The results of both shaking table and magnetic separation experiments clearly
showed that a 1×0.5 mm fraction was not suitable to direct processing without any size-reduction
process due to its low particle liberation degree.
The CSA value of 0.5×0.212 mm gravity concentrate was increased from 74.83% to 84.31% with a
recovery rate of 98.89%. Moreover, the overall recovery rate obtained by the sequential application of
the gravity and magnetic separation processes was about 69.14%. Additionally, similar to the 1×0.5 mm
fraction, the CSA value of gravity middling of 0.5×0.212 fraction was decreased from 0.90% to 0.68%
after the application of 2 A and 25 A magnetic separation. The obtained results were indicated that both
gravity and magnetic separation experiments were effective on 0.5×0.212 fraction in terms of enrichment
without a prior comminution process while providing a sufficient recovery rate.
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Fig. 6. Results of magnetic separation performed on (a) 1×0.5 mm gravity middling, (b) 1×0.5 mm gravity
concentrate, (c) 0.5×0.212 mm gravity middling, (d) 0.5×0.212 mm gravity concentrate, (e) 0.212×0.038 mm gravity
middling, (f) 0.212×0.038 mm gravity concentrate

Finally, the CSA value of 0.212×0.038 mm gravity concentrate was increased from 83.46% to 88.06%
with a recovery rate of 98.55%. On the other hand, the overall recovery rate obtained by the sequential
application of the gravity and magnetic separation processes was about 91.35%, which was the highest
recovery among all of the size fractions. Additionally, similar to 1×0.5 mm and 0.5×0.212 mm fractions
yet in a rather limited manner, the CSA value of gravity middling of 0.5×0.212 fraction was decreased
from 1.68% to 1.59% after the application of 2 A and 25 A magnetic separation. Accordingly, it can be
said that generally the 25 A non-magnetics of all fractions can be used, albeit after grinding of the 1×0.5
mm and 0.5×0.212 fractions due to the low liberation, for feed to a quartz/feldspar recovery. Finally,
the obtained results were indicated that both gravity and magnetic separation experiments were
effective on 0.212×0.038 fraction in terms of enrichment without a prior comminution process while
providing a sufficient recovery rate.
3.4. Zeta potential measurements
In literature, the ZPC values of quartz range from 1.7 to 2.6. These differences may arise from the
difference in production, storage, and surface properties of the quartz. ZPC of quartz can be established
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only by extrapolation since it occurs in a low pH range, and the acid side of the curve is not accessible
to electrokinetic measurement (El-Salmawy et al., 1993; Bu et al., 2017). On the other hand, the ZPC of
magnetite values ranged from 3 to 7 (Kosmulski, 2009). Milonjić et al. (1983) stated that the ZPC of
magnetite decreased to 3.8 after the treatment with HCl due to possible structure changes on the
magnetite surface. The zeta potential results of pure quartz and magnetite samples are shown in Fig. 7.
The ZPC value of the magnetite was determined as approximately 3.8. It was thought that the difference
between the obtained ZPC value of the magnetite and the values presented in the previous studies
might be attributed to the possible alteration of the magnetite samples due to weathering conditions in
the ore reserve.
On the other hand, the quartz sample showed a negative surface charge in the examined pH range.
However, under high alkaline conditions, the quartz surface charge increased to -60 mV due to the
increase in OH- concentration. In the case of extrapolation of the obtained zeta potential profile, it can
be seen that the ZPC of the quartz will be about pH = 1.8. This result revealed that the obtained zeta
potential curve was similar to the typical zeta potential curves of the quartz in literature, and was
consistent with previous studies. The surface charges of quartz and magnetite minerals in the range of
pH 2 to 4 indicated different markings supported by measurements, and it was determined that the
difference between the surface charges of these two minerals reached a maximum level at pH 3.
According to these results, two different flotation schemes, namely an anionic flotation scheme using a
depressant and an activator and a cationic flotation scheme using only a collector were established.
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Fig. 7. Zeta potential profiles of magnetite and quartz samples as a function of pH

3.5. Flotation experiments
The anionic reverse flotation experiments using NaOl and CaCl2 and the cationic reverse flotation
experiments using Flotigam EDA as the collectors were performed to improve the CSA values by the
removal of the light-colored quartz-rich contents from the concentrate obtained from the sequential
gravity-magnetic separation experiments. The CSA values of the concentrates obtained from the
flotation experiments and the recovery rates calculated based on these values are presented in Fig. 8. As
a result of the anionic reverse flotation experiments using NaOl, a slight increase, 84.64% to 84.76%, in
the CSA value of the concentrate (sinking) was obtained. On the other hand, 1.66% of the dark-colored
magnetite-rich content was lost in the tailing (floating) fraction. When the results were analyzed in terms
of light-colored quartz-rich fraction removal, it was determined that only 2.58% of the light-colored
quartz-rich content in the feed sample could be removed with the anionic reverse flotation using NaOl.
Again, a slight increase, 84.64% to 85.16%, in the CSA value of concentrate (sinking) was obtained in
the cationic reverse flotation experiments using Flotigam EDA. However, 3.71% of the dark-colored
magnetite-rich content was lost in the tailing (floating) fraction. When the results were analyzed in terms
of the removal of the light-colored quartz-rich fraction by the anionic reverse flotation experiments
using Flotigam EDA, it was found that 7.54% of the light-colored quartz-rich content in the feed sample
could be removed. However, the results obtained with Flotigam EDA were relatively higher than those
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with NaOl in terms of both the increase in the CSA value of the concentrate and light-colored quartzrich fraction removal.
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Fig. 8. Effect of flotation experiments on CSA and recovery (a) using anionic flotation on dark-colored magnetite
rich fraction, (b) using anionic flotation on light-colored quartz-rich fraction, (c) using cationic flotation on darkcolored magnetite rich fraction, (d) using cationic flotation on the light-colored quartz-rich fraction

3.6. Comparison of DIP and ICP assay values
To determine the reliability and sensitivity of the CSA results calculated by the DIP method, Fe2O3 and
TiO2 grades of the flotation feed sample and cationic flotation concentrate were also analysed using the
ICP method, which its details were presented in Section 2.1. Moreover, the XRD result of the flotation
concentrate, which was conducted to identify iron and titanium-bearing minerals within the final
product, is shown in Fig. 9. A comparison of the results for the DIP and ICP analyzes is presented in
Table 4.
Table 4. Comparison of the results for the DIP and ICP

Flotation Feed
Flotation Concentrate

DIP/CSA
(%)

Fe2O3

84.64
85.16

76.16
79.13

ICP (%)
Fe2O3+TiO2
85.58
88.30

Variation (%)
Fe2O3
Fe2O3+TiO2
+11.13
+7.62

-1.10
-3.56

As seen in Table 4 and previously presented, the CSA values of the cationic flotation feed and
concentrate were calculated as 84.64% and 85.16%, respectively. On the other hand, using the ICP
method, the Fe2O3 grade of the same products were determined as 76.16% and %79.13, respectively.
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Therefore, while the slight grade increase with cationic flotation was successfully determined with both
methods, the CSA values of the samples are higher in both cases than the ICP results. These results can
be attributed to the fact that the CSA values are concurrently represented dark-colored-mafic minerals
other than the iron minerals due to limitations of the used methodology.
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Fig. 9. XRD result of the flotation concentrate

In this regard; TiO2, which is the second-highest content originated from dark colored-opaque
minerals was also taken into the consideration and Fe2O3+TiO2 grades were also evaluated. As stated
in the results of XRD analyzes and optical microscope inspection, TiO2 content in the sample is mainly
associated with ilmenite and titanomagnetite particles, which was confirmed with further inspections
carried out on the flotation concentrates. It was found that Fe2O3+TiO2 grades of the flotation feed and
concentrate determined by the ICP method were 85.58% and 88.30%, respectively, which were very
close to and only negatively variated in the range 1.10-3.56% from the CSA values. Therefore, it can be
said that the simultaneous evaluation of ICP results of Fe2O3+TiO2 correlates better with the calculated
CSA values than the former option, where the only Fe2O3 grade is taken into consideration. Hence, the
application of a correlation coefficient derived from these results would be sufficient in terms of an
accurate representation of the Fe2O3 grades.
Gulcan and Gulsoy (2017) have pointed out that optical sorting, which is a method based on DIP, of
quartz and magnesite samples were resulted in high sorting efficiencies due to fact that both samples
having high color contrast among their particles. On the other hand, it was also stated that the same
separation method arose some challenges for the samples that have moderate color-contrast (lignite and
hematite) and low color contrast (copper and gold). Sousa et al. (2020) have also stated that the optical
sorting of a coarse-grained fraction of a Li-Mica lepidolite ore would be feasible due to the high-contrast
between valuable and non-valuable particles and the optical separator performance become lower when
color contrast decreases. Similar to these examples, the high contrast requirement is the main limitation
of the procedure presented in this work in terms of a successful application.
Finally, these results showed that the DIP analysis can be successfully used for the determination of
dark-colored mineral ratios and grades in the iron concentrate production from silica-rich river
sediment or other similar ores, where a distinct color difference is present between the valuable and
gangue minerals.
4. Summary and Conclusions
In this study, the possibility of iron-rich heavy mineral concentrate production from silica-rich river
sediment with SiO2 and Fe2O3 contents of 59.16% and 6.82%, respectively, obtained from the Canakkale
region of Turkey, by gravity, magnetic separation, and flotation methods were investigated. The
mineral processing experiments were carried out by using a laboratory scale Wilfley type shaking table,
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a wet high-intensity chamber type magnetic separator, and a Denver flotation cell on the 1×0.5,
0.5×0.212, and 0.212×0.038 mm fractions of the head sample. The DIP method was used to determine
the mineral content of the products obtained from enrichment experiments and indirect calculation of
the recovery rates. The results of the DIP analyzes showed that it was possible to successfully determine
the dark-colored mineral ratios and grades in the iron-rich heavy mineral concentrate production from
a silica-rich river by the application of the investigated methodology with a correlation coefficient
derived from the obtained results. However, it should be noted that the DIP analyzes solely based on
color/contrast differences have their limitations due to the necessity of a distinct contrast/color
difference between the minerals within an ore. Therefore, the applicability of the procedure presented
in our work should be separately evaluated for the analyzes of different ore types, especially for the
ores that have limited contrast/color difference between the ore/gangue minerals.
As a result of the gravity and magnetic separation, it was determined that the production of
concentrate with the CSA value of 84.64% from the 1×0.5 mm, 0.5×0.212, and 0.212×0.038 size fractions
can be achieved under the conditions investigated. Additionally, it was also determined that a 1×0.5
mm size fraction should be enriched after a grinding stage due to the insufficient liberation degree of
the fraction.
In the flotation experiments, an increase in CSA values of concentrates was slight in both anionic and
cationic flotation schemes, as a result of the low amount of quartz-rich fraction floating due to
difficulties encountered in froth formation and stability. After the cationic flotation, CSA values of the
final concentrate and general recovery rate of iron-rich heavy mineral fraction were calculated as 85.16%
(79.13% Fe2O3) and 57.81%, respectively. The chemical composition of the final iron-rich heavy mineral
concentrate and quartz-rich silicate concentrates are given in Table 5.
Table 5. Chemical analysis results of the final iron and silicate concentrates
Oxides
Al2O3
Fe2O3
K2O
CaO
MgO
Na2O
P2O5
SiO2
TiO2
LOI

Assay Values (%)
Iron Concentrate
Silicate Concentrate
2.88
22.26
79.13
0.23
0.12
1.06
0.41
6.01
0.97
0.09
0.31
6.96
0.40
Not Detected
5.53
62.48
9.17
0.00*
0.54
0.32

As seen in Table 5, the iron grade of the final concentrate is rather low for conventional iron
production processes. However, several studies have shown that the low-grade (27-45% Fe) iron ores
can be utilized in iron processing by alternative pre-processing strategies such as smelting after
pelletizing with coal and bentonite (Srivastava and Kawatra, 2009) or reduction roasting (Ray et al.,
2018), then the applying a LIMS step for both processes. Additionally, there are several direct smelting
technologies have been applied in the iron smelting industry for different low-grade iron materials,
albeit with several advantages or disadvantages (Anameric and Kawatra, 2008).
The results obtained in this study show that it is possible to produce both an iron-rich heavy mineral
concentrate and a potential feed for the production of quartz sand and feldspar concentrates from the
ore with the application of the flow chart given in Fig. 9. However, the investigation of the removal
possibilities SiO2, Al2O3, TiO2, and other impurities (Table 5), in terms of the evaluation of the suitability
of the concentrate for iron production processes is recommended for further studies. Additionally, a
quartz/feldspar separation with flotation seems to be necessary as the silicate concentrate contains a
significant amount of feldspar mineral in addition to the quartz content. Finally, further investigations
of the causes and possible solutions to the difficulties encountered in froth formation and stability are
also recommended.
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